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Description 
At Autodesk University 2018, the speaker successfully delivered 101 tips in 90 minutes. This 
year, we’re changing it up by starting with a blank canvas and building up a design from scratch, 
ending with documentation and manufacturing tips and tricks. Sketching, modeling, assemblies, 
third-party CAD models, generative-designed parts, sheet metal, and CAM will be part of the 
workflow. Everyone loves a quick-fire class full of productivity and power-user tips and tricks, 
and this class will deliver on that with context. Fusion 360 software is a big product, with lots of 
environments to master. No matter if you’re a beginner or a seasoned veteran, there are always 
new tips to learn from different perspectives. Come along to see practical application of the tips, 
tricks, and best practices you’ll undoubtedly learn in this class. 
 
Speaker(s) 
CAD Manager/Applications Engineer with a reputation of continuous improvement and 
innovation via a thorough understanding of manufacturing design processes, software and team 
management. Expertise in 3D CAD technologies, PDM & PLM, CAM programming, CNC 
machine operation, process documentation, technical training/support and R&D. A team leader 
who’s very active with self-improvement via online learning and collaborating with his peers. 
Well known for sharing his knowledge effectively via multiple forms of media. Experienced with 
managing diverse teams with an International project portfolio. A decade of experience working 
on luxury projects for High Net Worth Individuals. Hugely passionate about Formula One both 
as a sport and an engineering discipline. 
 

Learning Objectives 
• Learn how to apply Fusion 360 modeling, assembly, and manufacturing best 

practices  
• Learn how to integrate dozens of Fusion 360 shortcuts into daily workflows 

recognizing when to use keyboard modifiers 
• Learn how to create a fully functional mechanical assembly, with a mixture of 

custom and off-the-shelf components 
• Learn how powerful an integrated manufacturing and engineering platform can be 
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General & User Interface Fusion 360 Tips  
This section will cover tips which will help you throughout Fusion 360. 

1. New Component 
 
One of the most important tips you can know when starting out with Fusion 360, is to create a 
new component before you do anything else. This is true 95% of the time. If you are only 
designing a single component, like a bolt, then there is no need. But if you wanted to model a 
nut, bolt and a washer, you need to create one component per item. Doing it first as a matter of 
habit, will save you a lot of extra work later on, and result in a far more organised design. Fusion 
360’s New Component command can be accessed two different ways: 
 
a. Right Click on Top Level Node in the browser 

 
 

b. Select the command from the Ribbon 

 
Just remember, if you want to create additional Components, think about your assembly 
structure. You may not always want the top level to be the parent, you can also right click on an 
existing component, and create a New Component inside that one instead. As soon as one 
component contains another component, it becomes an assembly instead of a part. 
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2. Keyboard Shortcuts 
 
Autodesk Fusion 360's keyboard shortcuts are customisable:  

 
Early in 2018 the Fusion 360 development team released support for customisable shortcuts, 
you can now setup a shortcut for any command by clicking on the ellipsis button next to each 
command in the menus. 
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3. Set Current View As 
 
The view cube is an essential user interface element in Fusion 360. You must become familiar 
with it, and how it impacts your workflow to truly feel comfortable when using Fusion. Visually 
and functionally it’s very similar to what you will find in many other Autodesk CAD products. The 
view cube influences the following things: 
 
1. Your lighting orientation… take a look at the shadow on the view cube and compare it to 

the shadow and lighting on your model. 
2. If you prefer to use Constrained Orbit (which is the default orbit type), then setting the 

‘Top’ correctly will make Orbiting much more predictable. 
3. View Cube settings are independent between the Design and Manufacture workspaces. 

Allowing you to configure your views differently to suit your needs. 
4. Drawing views can also be chosen based on the view cube faces. 
 

 
 

4. Zoom Fit / Extents 
It’s pretty easy to orbit your model right off your screen. Especially if you are 
in the early days of navigating around 3D CAD packages. It happens to even 
the most seasoned CADders. But there’s an awesome trick which works in 
most CAD packages. Double click your middle mouse button, and your entire 
model will zoom to fit back onto your screen.  
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5. Escape & Left Click 
Just like Ctrl + S for saving should be a nervous twitch for most CAD users. In Fusion 360 one 
of the things I find myself doing often; is pressing the Escape key on the keyboard and left 
clicking repeatedly on free space in the background. This ensures there aren’t any commands 
active and no objects are selected which could be causing Fusion to behave oddly. A good 
example is having an arc or point selected before you start to dimension between two straight 
edges. In this scenario, you will be expecting to see a linear or angular dimension, but instead 
you get a radial one. 

 
 

6. Repeat Last Command 
An essential part of any CAD 
modellers toolset is knowing how to 
repeat your last command. Fusion 
360 relies on mouse gestures to 
achieve this. With no command 
active, right click, hold and move your 
mouse forward. This will sweep up 
through the 12 o’clock portion of the 
context menu.  
 
As an added bonus, save yourself 
some mouse movement, by using 
swipe right to select OK, instead of 
moving across to the command dialog 
to select the OK button.  
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7. Select Other / Parents 
This tip can be useful right at the beginning of a design when you want to place a section sketch 
on a different WCS plane, after modelling the base feature. Or when you want to select the 
parent assembly of a component in the graphics window. Just left click and hold, without moving 
your cursor, and a two tab dialog will pop up at the tip of your cursor.  
  

 
SELECT OCCLUDED OBJECT 

 

 
 
 
Select the item you want and continue with your work. This works with and without a command 
active. 

SELECT PARENT OBJECT 



 
 

 
Page 7 

8. Ctrl / ⌘ Selections 
Using Ctrl on Windows and Command on a Mac is a very handy computing skill, but a lot of 
people either don’t know about it, or don’t realise they can use it in CAD as well. Their use in 
Fusion 360 is no exception. It can be used for selecting objects in the browser (Components or 
Toolpaths), the timeline, or in the graphics window. 

 
 
Fusion 360 however does have a unique application for it in the Design Workspace. When 
editing an existing feature like a Fillet or Chamfer, you need to press and hold Ctrl/ ⌘ to add or 
remove additional selections. 
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9. Mouse Pan, Zoom, Orbit Preferences 
You can change the default button configuration for your mouse to suit CAD software you may 
have used in the past.  
 

 
10. Free vs Constrained Orbit 
The out-of-the-box setting for orbiting in Fusion 360 is Constrained Orbit. Which can make 
orbiting feel restrictive if you aren’t on top of your View Cube settings. The constrained orbit is 
locked to orbiting around the axis between the Top & Bottom planes of the View Cube. So 
essentially you can imagine your model being on a turn table which can also orbit. Whereas the 
Free Orbit option allows your model to ‘tumble’ in any orientation. 

CONSTRAINED ORBIT FREE ORBIT 
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11. Orbit Wheel 
The Orbit Wheel is another common 
user interface element across a lot of 
Autodesk CAD products, and it has a 
few hidden functions. Each element 
on the wheel will display a different 
cursor icon giving you a clue as to its 
function. 
 
You can also reset the orbit centre to 
the current position of the crosshairs 
by left clicking. 
 
 
 
 
 
 
 

12. Set / Reset Orbit Center 
When orbiting using the keyboard / 
mouse combo, as opposed to using 
the Orbit command. You can modify 
the orbit center using the context 
menu. Or you can do it on-the-fly by 
pointing to your desired orbit center, 
then while holding Shift, click with 
your middle mouse button. You can 
free orbit without using the command 
by holding down the Shift key on your 
keyboard and holding down your 
middle mouse button. Unless you 
have changed your navigation 
preferences. This video shows it in 
action. 
  

 

https://youtu.be/w2ywKu5AUdc
https://youtu.be/w2ywKu5AUdc
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13. Window Selection 
Wrapping your head around this tip will make your life a lot easier when it comes to selecting 
objects with finesse. When dragging a window from the top left to the bottom right, all selected 
objects will be fully enclosed within the window. Dragging from the bottom right to the top left will 
select all objects the window touches.  

 
14. S Key 

The S key is the single most useful 
command in Fusion 360. Press it, and all 
of its commands are at your fingertips. Not 
only is it a filtering search tool, but it’s also 
a contextual customisable toolbar. 
Meaning you can pin the commands you 
use the most in the Sketch environment, 
and they only show up while sketching. 
The same goes for each Workspace, they 
each have their own S key toolbox. To add 
commands, search for them, then click the 
curved arrow. To remove them, just drag 
them off the toolbox. 
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15. Versions 
Each time you save your design, you can 
enter a comment about your recent 
modifications. If you enter a custom value, 
instead of leaving the default one, then it 
will show up next to the version in the Data 
Panel. To access all the versions of your 
design, you can click on the version number 
itself. In doing so you are presented with 4 
tabs, Versions, Uses, Used In and 
Drawings. In the versions section you can 
see each version, the date it was created, 
who created it and a thumbnail. If needed 
you have the option to promote each 
version to the latest version or open the 
version. 
 
The rest of the tabs give you the ability to 
assess impact of change on a design, as 
well as view a list of all the drawings which 
use this design. 
 
 
 
 

16. Go Back 
Everyone has done it… you 
choose the Data Panel home 
button, the chevron, instead of 
going back up a level in your 
project folder structure. So now 
you have to drill back down 
through the project and folder 
structure to get back to where 
you were. But there’s no need… 
there is a stealthy little back 
button on the project home 
page you can use instead.  
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17. Data Panel Breadcrumb 
Each element in the breadcrumb has a purpose and functions in a very similar way to the 
Windows Explorer breadcrumb in its address bar. Click the arrows to jump across folders via the 
resulting drop-down menu, and click the folder names directly to navigate straight to that 
location.  

  
18. Offline Cache 
If you travel a lot for work, have unreliable internet, or just want to make sure you have your 
core designs available at all times. You have a few options: 
 
1. Automatic caching based on a duration setting in Preferences. 
2. Project caching (right click on your project and choose Cache This Project) 
3. Design caching (right click on your design and choose Add to Offline Cache) 
 
The first option shouldn’t be relied on, since it’s susceptible to too many factors which may 
result in you not having a local cache of your data when you think you should. The latter two 
options are super helpful but are a one-time only gig. If a new version of the design is created 
and saved from another device, then your device won’t automatically sync that change. You 
must manually cache again. 

19. Use Fusion Team 
When you use Fusion 360 for the first time, you are accessing it as a user, NOT a company. In 
the same way you access Dropbox as a private user. This is fine for single users, but if you are 
part of a company, or own a company with employees using Fusion 360, you need to get onto 
Fusion Team ASAP. Fusion Team is ‘like’ Dropbox for Business and allows companies to take 
complete ownership over the designs and projects their employees are creating inside Fusion 
360. It’s also a bit like using a network drive (Fusion Team), instead of everyone working on 
their own hard drives (Fusion 360 My Hub). On top of this massive benefit, you also gain extra 
features not available in the standard issue My Hub:  
 
• Share designs across projects 
• AnyCAD for Fusion 360 via the Desktop Connector 
• Desktop Connector 
• Common CAM Asset folders for posts, tool libraries, machine configurations and 

templates. 
 
You can click on this link to kick off the MyHub to Fusion Team onboarding workflow. 

https://login.autodesk360.com/login/signup?edition=business&product=fusion&onboarding=true
https://login.autodesk360.com/login/signup?edition=business&product=fusion&onboarding=true
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20. AnyCAD 
AnyCAD technology allows you to reference 3rd party 
CAD data as if it was native Fusion 360 data. So get this 
setup you need to: 
 

1. You have to be signed up for Autodesk® Fusion 
Team. If you are not signed up yet, click here to 
learn how to do so.  

2. You have to be a part of a Team Hub and have it 
set as the active Team in Fusion 360.  

3. Desktop Connector has been properly installed. 
Click here to learn more.  

4. Make sure that the AnyCAD preview checkbox is 
enabled in the Preferences dialog. 

 
From there you can browse through your Team 
Hub projects and folder structures, saving 3rd 
party CAD data where you need to. Once 
uploaded via the Fusion Team Desktop 
Connector, you can right click on any of those 
files, and insert them into a saved Design file in 
the same way you can reference in other Fusion 
360 designs. From there, you can work with the 
data as normal, and everything updates to 
match any future changes in the geometry of 
that file. Check out this example with soft jaws & 
CAM.  

21. Reference files from a different Project 
From the very beginning of Fusion 360, users have wanted 
to reference designs from one project into another. This isn’t 
possible with the standard Hub, but it is when you are 
logged into a Fusion Team Hub. Just drag-and-drop or right 
click and select Insert into Current Design as you would 
normally, it’s as simple as that. As a bonus Derive also 
works across Projects in a Fusion Team Hub as well.  

22. Reset to Default Layout 
So… you’ve lost all your toolbars, and the browser? The 
toolbar customisation reset tools aren’t doing the job… 
where’s the next port of call? The File menu; under the 
View submenu select Reset to Default Layout, and all will 
be right in the world again. 
  

http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-8C18EED5-0C11-4AD7-89C5-85A81EF8906C
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-8C18EED5-0C11-4AD7-89C5-85A81EF8906C
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-8C18EED5-0C11-4AD7-89C5-85A81EF8906C
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-8C18EED5-0C11-4AD7-89C5-85A81EF8906C
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-8CE8D2D4-25D0-44F4-A95A-E248B55B4888
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-8CE8D2D4-25D0-44F4-A95A-E248B55B4888
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-2EFA2D4A-89AC-4876-9E70-AD664BAFD122
http://help.autodesk.com/view/FSNT/ENU/?guid=GUID-2EFA2D4A-89AC-4876-9E70-AD664BAFD122
https://help.autodesk.com/view/CONNECT/ENU/?guid=GUID-847CE3FC-B26F-46B8-895E-5D825F4BD540
https://help.autodesk.com/view/CONNECT/ENU/?guid=GUID-847CE3FC-B26F-46B8-895E-5D825F4BD540
https://help.autodesk.com/view/CONNECT/ENU/
https://help.autodesk.com/view/CONNECT/ENU/
http://help.autodesk.com/view/fusion360/ENU/?guid=GUID-878489CD-3A23-4303-8450-C2F4F8E410B1
http://help.autodesk.com/view/fusion360/ENU/?guid=GUID-878489CD-3A23-4303-8450-C2F4F8E410B1
https://youtu.be/fcbWc1VAhcA
https://youtu.be/fcbWc1VAhcA
https://youtu.be/fcbWc1VAhcA
https://youtu.be/fcbWc1VAhcA
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23. Fusion 360 App Store 

 
There are loads of awesome apps to download and install on the Autodesk Fusion 360 App 
Store. Massif.dev is also an up and coming alternative to the Autodesk App Store, so be sure to 
keep an eye on that too. 
 

24. Slicer for Fusion 360 
Slicer for Autodesk® Fusion 360™ slices and converts 3D 
models into 2D patterns that you can cut out of any flat 
material. It also creates 3D instructions you can interact 
with, to help assemble your model. 
 
Create a model in Fusion 360 and with a few clicks you can 
send your model to Slicer for Fusion 360. Apply various 
slicing techniques to your model and create 2d plans in 
EPS, DXF or PDF formats that you can cut using Laser 
cutter or CNC machine. 
 
Slicer for Fusion 360 can be used standalone or as an add-
in for Fusion, and lets you use different construction 
techniques to build your model based on 2D slices and 
animated assembly instructions. 
Download it from here. 
  

https://massif.dev/
https://massif.dev/
https://apps.autodesk.com/FUSION/en/Detail/Index?id=8699194120463301363&os=Win64&appLang=en
https://apps.autodesk.com/FUSION/en/Detail/Index?id=8699194120463301363&os=Win64&appLang=en
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Fusion 360 Preferences 
Access your preferences by clicking the drop-down next to your username in the top right corner 
of the Fusion 360 application window. 

25. Preview Mode 
This is where Autodesk put their shiny new goodies for you to try out and provide feedback on. 
Some of them are well worth using in your everyday workflows. Others are quite early in their 
development cycle for ‘production’ use, so they should be experimented with that in mind. Once 
you are in the Preferences dialog, select the Preview option from the browser on the left-hand 
side. 
 

 
 
All of these are worth having a look at. So go ahead, turn them on and accept the T’s & C’s. The 
Mesh & AnyCAD previews are on permanently in my configuration.  

26. Set default material 
Are you fed up with constantly changing the material of your components over to your most 
common material? Don’t be, jump into your Preferences and on the Material tab you can 
configure your default material and appearance.  
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27. Scale entire sketch at first dimension 
When you’re laying out a sketch for the first time, you often just need to get the rough profile 
built out, then worry about dimensions and sketch constraints later. The trouble is, when you 
add the first dimension, it’s a regular occurrence that your sketch will turn itself inside out, 
especially if you have any arcs included in your profile. In mid-2019 the Fusion 360 team added 
a handy new option to the 
Design tab of the 
Preferences dialog. Enable 
the Scale entire sketch at 
first dimension check box 
and Fusion will scale the 
entire sketch based on the 
difference between the 
original sketch object size 
and the new one defined by 
your dimension. 
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Sketching 
Sketching is the foundation of any 3D model. So it’s important to create stable and reliable 
sketches, especially when modelling with History enabled in Fusion 360. When using the history 
free, direct edit, mode in Fusion it’s not quite as important. Nevertheless, being able to sketch 
quickly and efficiently is a fundamental skill with 3D modelling. This section will help you in that 
endeavour.  

28. Sketch Pallet Modifiers 
The sketch pallet in Fusion 360 is a hybrid of the old school pre-ribbon & new school context 
sensitive ribbon user interfaces. AutoCAD also uses pallets extensively. But this sketch pallet in 
Fusion 360 is highly context aware, and constantly adjusts the options available based on the 

active command or objects selected in the graphics 
area. 
 
The Feature Options section will allow you to 
switch between rectangle, arc, circle, slot & polygon 
types, without having to go and select it from the 
ribbon sub menu system or search for it via the S 
key.  
 
The Options section allows you to turn some very 
useful things on & off…. Is your sketch getting too 
busy? Then turn off all the Constraints. Setting 
sketch geometry as Construction is also something 
you should be making a habit of doing if you aren’t 
already, since it makes your sketches more 
lightweight. Construction geometry isn’t included in 
profile calculation for modelling commands, it also 
makes your sketches a lot easier to look at, 
allowing you to focus on the profile geometry which 
really matters. 
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29. Click & Drag from Line to Arc 

 
Fusion’s Line command is actually a Polyline command, hence the icon. But to sketch out a 
polyline, you need to click twice to place the initial line, then click on the 2nd point of the line and 
drag away from it. In doing so you will see a tangent arc forming off the end of the line. Keep the 
left mouse button pressed until you are ready to place the end point of the arc. You can take 
advantage of snaps to reduce the amount of manipulation and constraints needed afterwards to 
make the arc fully defined.  

30. Double Click to end Line 

 
The green check mark is kind of annoying and often gets in the way, but there is a quicker way 
to end the current line without ending the Line command. 
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31. Infer Sketch Constraints 
Sometimes Fusion 360 wants to automatically apply/infer constraints to the incorrect adjacent 
sketch object, which can be annoying. However, you can influence which objects constraints are 
inferred between, but rubbing your cursor up against the object you want the current sketch 
object to be constrained to. This is something best shown in a video.  

32. Ctrl / ⌘ to suppress constraint creation 
By default Fusion 360 will try to project geometry through from the background into the current 
sketch to help define what you are currently sketching. While helpful, at times it’s highly 
undesirable, especially when you have a complex sketch or model with a lot of features. The 
same is true with ‘busy’ sketches, Fusion may try to infer constraints to other sketch objects you 
don’t want it to. The solution is to hold down the Ctrl / ⌘ key on your keyboard while sketching, 
this stops all constraints and projected constraints from being inferred/created. Check out this 
video for clarification. 

33. Filtered Sketch Constraints 

 
If you pre-select the sketch objects you want to constrain using the Ctrl / ⌘ key, then both the 
context menu & sketch pallet constraint list gets filtered to display only the valid constraints you 
could use for the current geometry selection. 

34. Click & Drag – Auto Perpendicular & Tangent 
This one is hard to describe without just seeing it in action. But if you click and drag the first 
point of a line from a circle or an arc, it will lock the line tangentially. If you do the same thing but 
move away from the circle/arc it will create a radial condition. The same technique can be used 
to ‘pull’ perpendicular lines from other lines. Check out the video. 
  

https://youtu.be/VYnsYdv5cTk
https://youtu.be/VYnsYdv5cTk
https://youtu.be/tRrgeeYr6eI
https://youtu.be/tRrgeeYr6eI
https://youtu.be/tRrgeeYr6eI
https://youtu.be/tRrgeeYr6eI
https://youtu.be/9BJwPmRSzig
https://youtu.be/9BJwPmRSzig
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35. Midpoint Selection 
If you want to dimension to the midpoint of a line/arc 
or create a constraint to the midpoint of a line/arc. 
Then you just need to hold down the SHIFT key to 
activate the midpoint snap. Once your cursor reaches 
the midpoint of the line or arc, a triangle icon with a 
coincident constraint X will appear. Click to create the 
constraint or dimension from that snap, once created 
a black point will appear at the midpoint.  
 
 
 
 

36. Constraint Troubleshooting 

 
With complex sketches, the number of constraints showing on screen can be immensely 
distracting when trying to troubleshoot the parametric nature of a sketch. To overcome that, just 
turn off the Show Constraints checkbox on the Sketch Pallet. Then when you select any sketch 
objects in the graphics window, it will display only the constraints relevant for that object.  
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37. Click & Drag to Trim 
Once you activate the Trim command, you don’t 
have to click each individual element. If there is a 
path to move your mouse through which will 
‘touch’ all the elements you need to trim. Then 
just left click and drag your cursor along that path 
to remove all those elements. 
 
 
 
 
 
 
 
 
 
 
 

38. Modify Dimension Type 

 
When dimensioning in a sketch, it’s possible to change the format of your dimension via the 
context menu. Make sure the dimension command is active, then right click. With the 
radius/diameter toggle, you need to have selected the arc/circle already to see the options. And 
the same is true when dimensioning a line at an angle. When it comes to choosing between the 
center or tangent dimension, you can set it prior to the first selection or prior to the second one. 
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39. Build Relationships between Dimensions 

 
To build intelligent models in Fusion 360, you have to learn how to leverage parameters to their 
fullest extent. You can easily make one dimension/parameter equal to another, by selecting the 
dimension on screen that you want it to equal. This will use the name of the parameter driving 
that dimension, instead of having to type in a duplicate numeric value. What’s more, you can 
use all those mad math skills you learnt in school! Fusion supports a full complement of 
algebraic operators for you to take advantage of. Think about design intent when doing this… 
do you always want one feature to be a 1/3 of the size of another. Yes? Then just type in 
parametername/3. Done! Be sure to check out all the functions you have available as well, 
because you can work out the min/max number of pattern instances you can fit within a certain 
distance etc… this stuff is SUPER powerful. 

40. Double Click to select Chain 

 
With no command active, double click a sketch element, and Fusion will select the entire edge 
chain around the profile.  

http://help.autodesk.com/view/fusion360/ENU/?guid=GUID-76272551-3275-46C4-AE4D-10D58B408C20
http://help.autodesk.com/view/fusion360/ENU/?guid=GUID-76272551-3275-46C4-AE4D-10D58B408C20
http://help.autodesk.com/view/fusion360/ENU/?guid=GUID-76272551-3275-46C4-AE4D-10D58B408C20
http://help.autodesk.com/view/fusion360/ENU/?guid=GUID-76272551-3275-46C4-AE4D-10D58B408C20
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41. Project Body 

 
Press P for Project, and you will notice on the Project dialog box that there are two filters. One 
for edges/faces and another for bodies. Selecting Bodies will allow you to project the silhouette 
outline, instead of just edges. In the case of a sphere there are no edges to select which 
represent the overall size of the body. Project body takes care of this. It’s a super useful 
command in many different scenarios. 

42. Slice 

 
Turning on Slice in the Sketch Pallet is really handy for when you need to create a sketch inside 
a component. 
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43. 3D Sketch 
The Allow 3d sketching of lines and splines option must be activated under the Design tab 
in Preferences for you to be able to create 3D sketches. From there you create the sketches a 
few different ways. 
1. Use the Include 3D Geometry command 
2. Use the Move command in a 2D Sketch to move sketch entities or points off the plane 
3. Snap to objects in other sketches or model entities while creating lines & splines 
The last point is only possible if you enable the 3D Sketch checkbox on the Sketch Pallet. 
 
Sketch Troubleshooting 
You shouldn’t have any issues with sketches you have created yourself. It’s most likely imported 
geometry you will have to troubleshoot. Nevertheless, these techniques aren’t fussy about the 
source of the sketch data, so give them all a try in your quest to clean up those sketches! 

44. Surface diagnostics 
 
If you can’t extrude a solid in the 
Model Workspace because there’s no 
profile to select, then the odds are you 
will be able to extrude a surface in the 
Patch Workspace. Once you have 
done this, you can use either the 
Stitch or the Patch tool to expose the 
point at which there is an issue in your 
sketch loop. In the case on the left 
you can see there is an additional 
edge which shouldn’t exist for the 
Patch tool to try and fill. 
 
At this point you can delete the 
extruded surface and edit the base 

sketch to take a closer look at that coincident relationship between those two objects. 

45. White Points & Select Other 
With the base sketch active, if you don’t see any white 
points, then make sure the Show Points checkbox is 
active on the Sketch Pallet. This setting is sticky within 
each sketch, so it’s possible for it to be ON in one sketch 
but OFF in another sketch. If you still don’t see any white 
points, then it’s possible you have two identical lines/arcs 
sitting on top of one another, and fully attached at both 
ends with coincident constraints. To check suspect 
geometry, click and hold it with your left mouse button so 
the Select Other dialog appears, then you can choose to 
delete one of the surplus elements.  
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46. Black Points 
What if you see black points in your sketch? While white points show unconstrained points, 
black points can be fully constrained duplicate points. You might see this if you place a sketch 
point at an intersection of several lines/arcs, or you have created a relationship to the midpoint 
of a line/arc or if a placed sketch point is coincident with a line/arc. Two other places you will 
see black points is at the center of a fully constrained circle, or the control points on a fit point 
spline. 

47. Divide & Conquer 
A super useful technique, and my go to when troubleshooting 
sketches is the divide and conquer method. Just draw a line 
across where you should be seeing a profile and move it around 
until you see a profile display. This allows you to quickly zero in 
on the area(s) of the sketch loop which are problematic. 

48. Move to Sketch Plane 
Once you have narrowed down the 
search area, its highly likely that 
the techniques outlined in the 
previous tips will allow you to fix 

the issue… but another handy trick in your arsenal, is to right click 
on some of the problematic geometry and see if the Move to 
Sketch Plane option exists. If it does, this means that some of the 
geometry isn’t on the same plane as the sketch. Essentially, it’s a 
fragmented 3D sketch. Window select all the geometry in the area 
which won’t generate a profile, right click and select Move to 
Sketch Plane to fix it all in one go. 
 
Modelling 

49. Open from my computer 
 
With some file types you don’t have to upload 
the files via the data panel or Autodesk 360 
website. From the File drop-down menu, you 
can select Open, then Open from my 
computer. You can import 4 common 3rd 
party file formats; IGES, SAT, SMT & STEP, 
as well as the native Fusion 360 design F3D 
file.  
 
This import method can be completed without 
an internet connection and so uses local 
translators to get the job done. Once you save 
the file, Fusion will sync the new design file to 
your Autodesk Cloud account. Either MyHub 

or Fusion Team depending on your configuration. 
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50. Importing IGES 

 
It’s not obvious when you import an IGES file into Fusion 360, but by default it imports each face 
as an individual surface body. You will notice something isn’t right if you start trying to perform 
extrude cuts or start programming toolpaths in the Manufacture workspace. If you expand out 
the Bodies folder (for the relevant component) you will see a full list of all the surface bodies. 
To fix this up, you need to switch to the Surface tab, and from the Stitch command window 
select all the surface bodies in the graphics area and stitch them all together. At this point the 
bodies folder should only show a single solid body. 

51. Uploaded via Autodesk 360 / Fusion Team? 
There are 3 ways to add 3rd party date to Fusion 360: 
1. Open from my computer  
2. Upload via the Data Panel 
3. Upload via Autodesk 360 (your Hub or Fusion Team Hub). 
If you upload via the first 2 options, the 3rd party data is immediately translated into a Fusion 360 
design. However, if you upload via the website or your Desktop Connector tool. Then the A360 
service will preserve the original data format. Meaning you can use the service instead of 

Dropbox (A360 understands CAD file 
relationships), or take advantage of the 
AnyCAD technology I covered in Tip 20. If 
it translated it immediately this wouldn’t 
be possible.  

 
Consequently, in the Fusion data panel, if 
you right click on the file you have two 
options to open the file (assuming you 

have the AnyCAD preview enabled and you’re in a Fusion Team Hub). 
1. Insert into Current Design (AnyCAD) 
2. Create Fusion Design (converts the data & saves a copy of the file)  
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52. Capture Design History 

 
Imported models don’t capture design history by default. As such they are in Direct Edit / History 
free mode, so there is no Timeline shown at the bottom of the Fusion window. To enable 
history, right click on the top-level node in the browser (normally the same name as your 
design), then select Capture Design History. You will now see a Timeline at the bottom of the 
Fusion window. Bear in mind, you can turn off history from the same context menu, however, it 
will permanently delete any build up history or features on your timeline. 

53. Bodies 
• Have a type  

o Solid 
o Surface 
o TSpline 
o Mesh 

• Made from features 
• Can be organized in folders 
• Do not move with respect to their parent 

origin 
• Can have materials (but probably 

shouldn’t) 
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54. Components 
• Any Design is a Component and can be a part, or an 

assembly 
• Fusion 360 calls both parts and assemblies 

“Components” 
o Any component can have child components 
o Any component can have 0, 1 or more bodies 
o Components have both bodies & child components 

• General rule: always create a component as soon as 
you know you need one. 

• Components can move relative to their parent origin 
• Activating components helps to manage your timeline 

o Components ‘own’ features & resulting bodies 
• Joints only work with components 
• Drawings can be (easily) made of individual 

components 
• Have part numbers and other properties 
• A BOM is based off components and their properties 
• Can have multiple occurrences 
• Can be saved out to a new design 
• Can be inserted 
• Each component has its own origin 

55. Extrude From 
This handy feature allows you to start an extrusion from a different plane to where the sketch is. 
In a similar vein you can select an object to extrude to, allowing you to ‘project’ a profile to 
create an extrusion between two different references nowhere near the sketch profile itself. 

• Select a Profile on 
another plane 

• Start - From Object 
o Grab arrow 

glyph and drag 
to start 

• Extent – To Object 
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56. Extrude to Body 
You can choose a body as the To Object extent of your extrusion. The profile will terminate 
following the topology of all intersecting faces on the target body. Even undercuts are included. 

 
When select the target body as the object, make sure you select the edge of the body to 
successfully select it. 

57. Offset Face 
To execute the Offset Face 
command, you need to press Q for 
the Press Pull command. It will then 
adapt to the selection you make. So, 
if you select a face, it will morph into 
the Offset Face command. Once 
active, there are essentially two 
modes, Modify Existing Feature & 
New Offset.  
 
However, the default is Automatic. 
If you select a face which is part of 
an existing feature, then the 
command will adjust the base 
dimension driving that feature, 
otherwise it will apply a new offset. 
Naturally, there are times when you just want to add say 2mm to an existing extrusion, this is 
when you would override the command to use New Offset instead. 
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58. Delete Faces 
If you select a face in Fusion 360 and press the 
Delete key on your keyboard, it will delete the 
face and heal it again thereby maintaining a 
solid. It’s an incredibly powerful feature in a lot 
of situations, which can save a lot of additional 
modelling. Or in the case of imported models, it 
can help greatly with troubleshooting poor 
geometry or defeaturing for the sake of 
representation only. Sometimes for it to work 
effectively you must select a group of logical 
faces, so make sure you use the Ctrl / ⌘ key to 
select all that you need for the operation to 
complete successfully. 
 
 
 
 

59. Destructive Repair 
Sometimes you must burn things with fire to 
start again. In CAD terms, a big fat boolean 
subtract is just the ticket. Dodgy fillets on 
imported models are often troublesome 
when trying to rework them. A neat workflow 
is to place a workplane on one of the edges 
(use Plan Along Path), then use a Sphere 
primitive from the Create drop down on the 
ribbon. Set it to cut away the model and 
expand its size just enough to remove all the 
troublesome faces. Then you can use the 
previous tip, Delete Faces, to either delete 
adjacent faces you couldn’t before, or delete 
the resulting concave spherical face itself. 
Fusion will then heal the model if it can. 
  



 
 

 
Page 31 

60. Name Objects 

If you rename your sketches, construction features and modelled features, working with your 
design becomes a lot easier in the future. Expanding out the sketch folder reveals a series of 
logically named nodes, allowing you to immediately edit the sketch you need, instead of 
bouncing in and out of hidden sketches to find what you need. However, the main point of this 
tip is to show you that by naming all these things, navigating the Parameters dialog becomes 
an absolute breeze. 

61. Edit from canvas 

 
Fusion’s Timeline is far from pleasant to use when you have a complex model with a lot of 
features. So even if you are a total legend when it comes to naming your objects, you’re going 
to need some extra help to find what you need. If you right click on a face which belongs to a 
feature, you will find an Edit Feature option in the context menu, if that feature is a child of a 
sketch, then Edit Profile Sketch will also be present. Selecting either of these will get you to 
where you need to be without hunting around on the Timeline. The Select Other popup 
appears if there is more than one possible Feature to Edit, just select the one you want to edit. 
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62. Derive all the Things 

 
There are two Derive commands in Fusion 360. Create Derive and Insert Derive. This tool 
unlocks a massive amount of power for Fusion which previously wasn’t possible. Two great 
examples are: 
1. Skeletal modelling – you can create a base Design 

with layout sketches and common parameters. 
Then you can derive that into a bunch of other 
designs, either individual parts or subassemblies. 
After that you can build the top-level assembly by 
inserting all the derived Designs into it. Gone are 
the days of humungous Timelines in Fusion. 

2. For CAM users, previously you had to include all 
construction geometry, fixture models, and 
toolpaths for each component inside one Design. 
Chaos quickly ensues. And if you work in a 
company where you have Engineers designing and 
Machinists programming, then Engineers tend to be 
protective over their work and don’t like Machinists 
messing with it. Plus, it completely stuffs up your 
BOM & potentially also the drawings. Now CAM 
programmers can Derive in just the component they 
need to ‘CAM up’ and build everything they need to 
achieve the result. 
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63. Materials & Appearances Favourites 

 
Instead of rummaging through the extensive list of materials and appearances all the time, you 
can create a list of favourites which you can access from any Design document. Just right click 
on the appearance and choose Add to Favourites. 

64. STL to Quad to Form 

 
There isn’t a native way of achieving this solely in Fusion 360 at this stage. The piece of the 
puzzle that’s missing is a Tris to Quads conversion tool. A quads model is what’s needed for a 
successful conversion to a T-Spline body. So, the current workflow is to either import the source 
STL into Meshmixer or Fusion 360 (with the Mesh workspace preview turned on), then perform 
any repairs needed and remesh to a maximum of 10,000 faces. At this stage you need to use a 
tool to convert the triangles into quads. I know of 3 options: 

1. Meshlab FREE (low quality) 
2. ReCap Photo (Subscription, high quality) 
3. Netfabb Standard (Subscription) 
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You may be able to get better quality quad output from Meshlab than I did, but ReCap Photo did 
a perfect job. This video does a great job of explaining the process. 
 
The other option, and sometimes it’s the only viable one, is to import the stl into Fusion, then 
reconstruct t-spline faces over the top using the Face & Pull Form commands. 

65. Create Mesh Section 

 
YES! You can create sections through meshes. You must be in the Design Workspace though, 
not the Mesh Workspace (you may need to enable the Mesh Workspace in the Preview tab of 
the Preferences dialog). From the Create drop down on the Solid tab, select Create Mesh 
Section Sketch. Then you just select the mesh body you want to section, and either precisely 
or visually position the plane through which you want to take the section. Done. 
  

https://www.youtube.com/watch?v=heFWhzNwPFI
https://www.youtube.com/watch?v=heFWhzNwPFI
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66. Fit Curves to Mesh Section 

 
IN THIS CASE, USING THE CLOSED SPLINE TOOL IS MORE APPROPRIATE 

Once you have created a Mesh Section, edit the newly created sketch in the Timeline. In the 
Create drop-down on the Ribbon, select the Fit Curves to Mesh Section tool to build an open 
or closed profile to use for modelling. This dialog has an extensive set of options allowing you to 
effectively reverse engineer your mesh into a full blown NURBS surface or solid. If you know 
that sections of the mesh should be flat or have fillets, then you can use lines & arcs etc. Then 
in more organic areas of the mesh you can use splines or closed splines to get the geometry 
you need. Top tip… if you are going to use splines, try to use the Closed Spline tool where ever 
possible, it does a fantastic job of creating great geometry. Once you have a series of sketches 
with valid profiles, you can use them to 3D model your component. 

67. Alt to add edges in Form 
With the Edit Form command 
active, select an edge, edge chain, 
face or face chain. But before you 
start tugging on one of those 
handles on the widget, mash down 
the Alt key and hold on. With each 
successive tug on your widget 
handle of choice, Fusion will gift you 
a new edge to play with. Pretty 
handy for gaining more control over 
the geometry of your freeform body. 
So, hold down Alt, click & drag, 
once your release you get an edge, 
click & drag and you get another 

edge.  
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68. Alt + Ctrl to add creased edges 

 
This one is similar to the previous tip, but instead of adding edges and maintaining G2 curvature 
on the adjacent faces, holding Ctrl as well will crease the edge instead. So use Alt + Ctrl then 
drag to ‘extrude’ a face from a creased edge. 

69. Make Uniform 

In the image on the left, you see the model looks a bit stressed. Extruding out that extra face 
didn’t go down too well. We could leave it, but it doesn’t look good, and we will likely regret it 
later. The star points formed by extruding the face with the Alt key, are pulling on the rest of the 
model too much. Using the Make Uniform command in the Utilities drop-down, will redistribute 
those points, relaxing the model, making it a much more reliable model to use moving forward. 

70. Shift + Up to grow Sculpt selection 
Once you have your initial face(s) 
selected you can grow the selection out 
‘radially’ by one face at a time by 
pressing the Shift & Up keys at the 
same time. Conversely Shift & Down 
will shrink the selection.  
 
For more Sculpt shortcut keys, you can 
refer to this Fusion 360 shortcuts help 
page. 
 
  

https://www.autodesk.com/shortcuts/fusion-360
https://www.autodesk.com/shortcuts/fusion-360
https://www.autodesk.com/shortcuts/fusion-360
https://www.autodesk.com/shortcuts/fusion-360
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71. Shift Double Click 

 
SELECT FIRST FACE(S), HOLDING SHIFT DOUBLE CLICK ADJACENT FACE 

 

72. Alter Form display mode 
Alt + 1, Alt + 2 and Alt + 3 will toggle the Form display mode between Box, Control Frame & 
Smooth respectively. Sometimes it’s easy to get lost editing in smooth mode, so switching to 
Box mode allows you to see the frame controlling the surface in a simplified representation. You 
still use all the Form tools as per normal. 
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73. Simplify 
Hidden away in the simulation 
environment are a series of 
simplification tools. They are 
naturally aimed at simplifying the 
model for Finite Element Analysis 
(FEA), but thanks to a sneaky 
Export option in the Browser 
context menu, you can save out a 
simplified version of your design. 
This can be super useful if you 
must provide a collaboration 
model, but don’t want to give away 
IP or overcomplicate things. BIM is 
a great example of needing to 
keep your models simple… so this 
may be useful for those of you 
creating products for buildings.  
 
To access the Simplify toolset you must create a fake Simulation Study in the Simulation 
Workspace. 
 
Assemblies 
74. Forgot to create a component? 
Tip number 1 was Rule number 1… but don’t worry if 
you’ve forgotten to do it, but in retrospect needed to, 
there is a way to fix it up in a lot of cases. 
 
1. Create a New Component 
2. Drag it to the beginning of the Timeline (or to 

where you want the component to be created) 
3. Then drag the sketches from the top-level design 

document Sketches folder onto the newly 
created component in the browser. 

 
Once you have done this, the new component owns 
those sketches, and any features created using 
them. 
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75. Rigid Joint to Origin on 1st Component 
In Inventor and Solidworks, you can ground your component. Generally this is best practice for 
the first component in your assembly, so you have a ‘fixed’ reference to work from for the rest of 
the assembly. However, in Fusion 360 the Ground option only applies to the component 
instance relative to its parent component, it’s effectively a local rather than global state. If you 
move it into a different level of the assembly hierarchy, then the Ground status gets removed. 
Joints are carried with a sub-assembly anywhere it is used, but the Ground flag isn’t. This is the 
fundamental difference between Grounding inside a sub-assembly in Fusion 360 vs Inventor. 

 
GROUND STATUS IS REMOVED. RIGID JOINT IS RETAINED. 

76. Paste New 
If you want to have 2 or more components 
of the same kind, then you can simply copy 
and paste the components. But what if you 
want the same basic component, with just a 
few tweaks and a new part number? That’s 
where Paste New comes into play. Copy 
the Component as normal, but this time, 
select Paste New from the context menu. 
 
Doing so will result in a brand-new 
component of quantity 1, with a fully copied 
timeline of features, which can be edited 
independently of the original component. 
Changes you make to this one won’t affect 
the other.  
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77. McMaster-Carr 

 
McMaster-Carr are an online engineering components eStore and they allow you to download 
3D models for nearly all their catalogue. It’s seriously impressive. Fusion 360 has integrated 
with their website, so from the Insert drop-down menu you can choose to insert one of their 
components.  

 
A new window appears allowing you to search and browse through their website. You can either 
search for a SKU directly, navigate through their menu system or use product filters to find what 
you need. To access the 3D models, you must select the 
part number hyperlink, then click the Product Detail link to 
get through to that product’s page, scroll until you see a drop-
down for selecting the file format you would like. I 
recommend you use the 3-D STEP file type, then click Save 
to have it inserted into your Fusion Design. 
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78. Component Colouring 
To enable this goodness just press Shift + N on your keyboard and 
Fusion’s graphics window morphs into something from Willy Wonka’s 
chocolate factory. Each component in the browser gets a colour bar, 
which corresponds with all the features each component owns in the 
Timeline and the components themselves in the graphics window 
also take on the same colour. 
 
As a bonus tip, if you click the gear icon on the Timeline, you can enable the colour bars in the 
Browser & Timeline without the components being coloured in the graphics window. 
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79. Free move on placement 
When you insert a component from the Data Panel, or copy and paste to create another 
component instance, the Move/Copy manipulator appears on screen. If you are capturing 
history, then this initial placement of the component is a ‘Free’ move. Fusion doesn’t try to track 
the position of the component until after it has been placed. So, it’s worth making sure you get it 
in a good spot for whatever you are going to be doing with it next. 
 

 
80. The Joint ‘Coin’ 

 
 Not used by ‘As-Built’ Joints 
 The semi-circle line aligns with X axis 
 The semi-circle arc points towards Y axis 
 The Z positive direction is driven by the XY direction and is normal to the coin 
 The Coins align by default, but can be adjusted using the Angle & linear offset input 

boxes in the Joint dialog 
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81. Lock Joint selection 
Sometimes the Joint origin you need to select is in thin air or occluded by another face. As a 
result, it can be tricky to lock onto and select. Holding down Ctrl on your keyboard will lock the 
face or edge selection, so you can mouse over to the origin you need to select to get the job 
done. 

 
82. Midplane Joint 

 

 
 

With the Joint command active, for either the 1st or 2nd input, you can right click to select the 
Between two faces option from the context menu. Once you have selected the two faces, you 
only need to select a reference for the Joint Origin from any of the valid snap points on that 
Component. The snap point doesn’t have to be on one of the seed faces. 
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83. Lock Joint 
This is handy if you are trying to troubleshoot your 
joints, or temporarily restrict motion without 
completely suppressing the Joint. Suppressing 
removes the Joint from motion calculations, but 
locking it just stops it from moving, similar to Rigid, 
but without changing the Joint type. 
 
 
 
 
 
 
 
 
 

84. Combine Cut using Assembly position 
 

Because Fusion 360 tracks the history of its component’s positions, you 
have the ability to use the components themselves to drive the geometry 
of adjacent or intersecting parts at various positions during their motion. 
Just position your components, capture their position on the timeline, 
then use your modelling operation of choice. This ball joint is a great 
example. 
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85. How many components are there? 
There are a number of addins you can install to get this information and there are some scripts 
on the forums you can use as well. But there isn’t anything in the Fusion user interface which 
easily gives you this information. However, you can access this information from the Text 
Commands pane: 

• Turn on the Text Commands pane (File > View > Show Text Commands) 
• Switch to the Txt radio button 
• Type component.counts & hit Enter 
• Look for LeafOccurrences value 
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86. Reverse for re-assembly 
 

 
 
The Animation workspace is where you go to create your exploded views for your drawings. 
But you can also create cool assembly animations and save them out as videos. Generally, the 
way things go together, is the reverse of the way they come apart. So, after you have finished 
creating your exploded view animation, you can right-click and Copy the Storyboard1, then 
Paste it as a new one. Be a good CAD person and rename it to exploded-reverse or something 
equally as meaningful. After that you can right click on that storyboard and select Reverse from 
the context menu, then hit play to feel a sweet sense of satisfaction having done a good day’s 
work in just a few seconds. 
 
Drawings 
87. Special Characters 
Fusion doesn’t support special characters, and several forms of engineering notation just yet. 
So if you have to get this information onto your drawings, then it can be achieved via the use of 
Alt codes or Unicode. Just type the codes into a text box on your drawing. Here are a few 
references you can use to find the codes you need: 
 
https://knowledge.autodesk.com/support/autocad/learn-
explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-
4A8A-AC32-2D85590CDBE1-htm.html  
 
http://www.thecontrolsfreak.com/2011/tech/alt-codes-you-look-smarter-simple-key-strokes/  
 
http://www.engineeredbydesign.co.uk/Pages/AltCodes.php  
 

88. Shift to suppress OSnaps 
When placing dimensions, you can toggle between a ‘grid’ like snap for the position or 
completely free movement. Most of the time using the grid snap helps you to quickly align 
multiple dimensions, whereas having fully free movement will allow you to precisely squeeze in 
additional dimensions. This behaviour is changed by using the Shift key to toggle it on & off. 

https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-4A8A-AC32-2D85590CDBE1-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-4A8A-AC32-2D85590CDBE1-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-4A8A-AC32-2D85590CDBE1-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-4A8A-AC32-2D85590CDBE1-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-4A8A-AC32-2D85590CDBE1-htm.html
https://knowledge.autodesk.com/support/autocad/learn-explore/caas/CloudHelp/cloudhelp/2019/ENU/AutoCAD-Core/files/GUID-518E1A9D-398C-4A8A-AC32-2D85590CDBE1-htm.html
http://www.thecontrolsfreak.com/2011/tech/alt-codes-you-look-smarter-simple-key-strokes/
http://www.thecontrolsfreak.com/2011/tech/alt-codes-you-look-smarter-simple-key-strokes/
http://www.engineeredbydesign.co.uk/Pages/AltCodes.php
http://www.engineeredbydesign.co.uk/Pages/AltCodes.php
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89. Smart Dimension OSnap 
When placing a Smart Dimension, you can choose to 
limit the objects your dimension points will snap to. 
Prior to selecting the point, you want for dimensioning, 
right-click and select an override (i.e: Center) from the 
context menu. You will need to do this for each 
dimension point you pick, since the selection resets 
back to auto.  
 
 
 
 
 
 
 
 
 
 
 

90. Stack Dimensions 
When creating a new dimension, while placing it, click on a dimension that it should stack with. 
They will stack appropriately, with the larger overall dimensions to the outside, and smaller 
dimensions on the inside. 
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91. Smart Templates / Custom Title Block 
 

 
 
Using the New Drawing Template command in Fusion 360 also allows you to create Smart 
Templates. The difference between the two is a standard template will generally only have a 

single sheet with zero drawing views. 
Whereas a Smart Template just adds 
placeholder views and tables and can 
contain more than one sheet of varying 
types.  
 
To get started, from the File drop-down 
menu select New Drawing Template. 
In the resulting dialog, choose the 
standard, units and primary sheet size. 
You can add different sheet sizes to 
the Smart Template later.  
 
If you want to modify the default Title 
Block, then double-click on the one in 
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the sheet which gets loaded. Then click the Edit Title Block button on the dialog which 
appears.  

 
 

Next you must choose if you want to use an existing Title Block as a starting point, start from 
scratch or import one from AutoCAD. You’re mostly likely going to want to select the default 
Title Block as a starting point. Give your new custom Title Block a name at this point before 
clicking OK. Use the sketch, text & attribute tools included on the toolbar in this environment to 
build up your custom Title Block. You may want to create more than one to suit each sheet size 
you create templates for. 
 

 
 
Once saved, you return to the main template workspace, where you can insert placeholder 
views and tables, as well as any drawing notes you may want to include. Create a new sheet by 
clicking on the + sign next to the last sheet created at the bottom of the screen. 
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You can create sheets for: 
 
• Assemblies 
• Storyboards (created in the Animation Workspace) which can either be exploded views 

or configurations of your design assembly. 
• Component 
• Folded Components 
• Flat Patterns 
• Linked full sheet parts lists Tables 
 
On each sheet you can pre-stage elevations, isometric & section views. For each view you can 
define view styles as you would when placing a normal view in a normal drawing. Once you are 
happy save the template and choose a meaningful name, since it will appear as a selectable 
option in the Create Drawing dialog in the future. Note: if you are using a Fusion Team Hub, 
instead of the standard personal Hub, then you can create a templates Project and save your 
templates into that. But still refer to them from other projects. 
 
To create a drawing package using your Smart Template, from your Design you want to 
document, in the File Menu select New Drawing > From Design and choose your newly 
created Smart Template from the Template drop-down. You may have to browse to find it the 
first time. Enjoy!! 
 
Rendering 
92. Lock View 
When rendering using Ray Tracing in 
canvas, the slightest knock of your 
mouse or keyboard will reset the render. 
NOT what you need when you’re 
angling for that final result. Fear not, all 
you have to do once you have the view 
setup, is click the In-canvas Render 
Settings button on the rendering 
Ribbon and activate the Lock View 
checkbox.  
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93. Re-Render as Motion Study 
 

 
 

Get the motion you would like to render out as an animation sorted by defining all your Joints 
and define a motion study. If you create a Named View for the camera angle suitable for the 
motion study, then a preview rendering will be created by Fusion automatically on save. 
Switching to the Render Workspace, have a look at the preview thumbnails in the Rendering 
Gallery at the bottom of the screen. If you click on the one for the Named View you created, in 
the resulting window you will have the option to Render a Motion Study. Click on that bad boy, 
select your motion study and quality settings and click Render. You will need some Cloud 
Credits to make this happen. Then crack on with some other work while the Cloud does its thing 
in the background. 

http://help.autodesk.com/view/fusion360/ENU/?caas=caas/video/youtube/watch-v-aFxZSBtVnIM.html
http://help.autodesk.com/view/fusion360/ENU/?caas=caas/video/youtube/watch-v-aFxZSBtVnIM.html
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94. Emissive Appearances 
There are a number of emissive appearances 
available in Fusion 360. These can be used to 
model up custom lighting rigs for rendering. Out-of-
the-box Fusion 360 gets the light it needs from the 
environment in the Rendering Workspace. By 
creating 3D models with emissive appearances, 
you can introduce additional light sources. A simple 
trick is to add two additional components to your 
design, the first being a Sphere, and the second a 
cylinder or a cone. Set the material of the Sphere 
to Air, so its becomes completely invisible, and 
assign an LED or Bulb appearance to the other 
component. Both of those appearances will emit 
additional light into the scene and can be directed 
onto certain objects easily. Position the Sphere so 
its center is at the center of subject you want to 
render, then use a Rigid As-Built Joint to lock it in 

place. Then use a Ball Joint to lock the axis of the conical/cylindrical component to the center 
of the sphere. At this point you can just drag the light emitting object around the sphere into the 
position you want. Jump into the Rendering Workspace and look at the impact it has on your 
rendering. Have a think about modelling in other objects to ‘stage’ your model and give the light 
more to bounce off, walls & a floor would be a great start. 
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Manufacturing 
95. Cloud Libraries / Fusion Team 
 

 
 

If you are a one-man band, then you should still consider activating Cloud Libraries in your 
Fusion 360 Preferences. Doing so will create an Assets Project in your Hub which will appear 
in the Fusion 360 Data Panel at the end of your Project list. 
 

  
 
Within that Project, 4 folders are created from Machine Configurations, Post Processors, 
Toolpath Templates and Tool Libraries. Upload your proven-out Post Processors into the 
CAMPosts folder. Setting this up means that you can log into any device and access all your 
own custom posts, tool libraries and templates if you have created any. And because those files 
are being looked after by Fusion you can version them all just like you can with your Designs if 
you so choose.  
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If you are using Fusion Team, then setting 
this up is a must, because it tightens up 
your programming users’ collaboration. If 
you enable Cloud Libraries in each 
users’ account, then they will all be using 
the same posts, templates and tools as 
each other, all seamlessly integrated and 
managed natively by Fusion 360. Just 
make sure each user switches over to 
your companies’ Fusion Team Hub.  



 
 

 
Page 55 

96. Selected Point WCS Origin 
The geometry of some parts and the details you are required to machine, sometimes means 
that finding a zero-reference point on the part can be tricky. You may have to ‘touch-off’ on 3 
different faces on the part to find it. This results in a ‘virtual’ reference point which you can’t 
define with the options in the CAM Setup alone… you need some ‘help’ from the Design 
Workspace. You may need to create some workplanes and/or sketches to find the point you 
need, but often the Point Through Three Planes would be all you need: 

 
From there you can select that Work Point as your reference when creating your CAM Setup. 
Just choose Selected Point from the Origin drop-down, then choose the Work Point you have 
created for the resulting input requirement. 
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97. Compare & Edit Defaults 
You may already know that you can right-click on any input box while creating or editing a 
toolpath and set the value as the default. But you can’t do that with drop-down values and 
checkbox states. To do this you must right-click on the toolpath and select Compare and Edit. 
Then you can search for the setting name, set the value you want (if you haven’t set it yet), then 
right-click on that input box and you will see the options you need to set the default. Be sure to 
select Make Default and not Make All Default. Selecting the latter will result in all values set for 
that toolpath becoming the default moving forwards, not just the value you want to set as a 
default.  

 
 

98. Use NC Corrector 
Download and install the Free NC Corrector so you can view your G-Code in a more viewer 
friendly format. To get Fusion 360 to open your NC file using NC Corrector at post time, go to 
your Preferences then on the Manufacture tab, set the External Editor input box to the 
following path: C:\Program Files (x86)\NC Corrector v4.0\NC_Corrector.exe 
 

99. Fusion 360 Adoption Portal 
Fusion 360 is a rather large product, with tonnes of different skill sets required to master it. If 
you want to learn some new skills and excellent place to start is the Fusion 360 Adoption Portal, 
be sure to check it out. 

http://www.nc-corrector.inf.ua/index_EN.htm
http://www.nc-corrector.inf.ua/index_EN.htm
http://www.autodesk.com/products/fusion-360/get-started
http://www.autodesk.com/products/fusion-360/get-started
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